
MobileSyncMail Setup 

Activate Microsoft Exchange ActiveSync 

Apples to: SmarterMail 8.x (Enterprise only) 

 

Microsoft Exchange ActiveSync is available as an optional add-on to SmarterMail and is 

associated to a specific SmarterMail license key at the time of purchase. Once you have 

purchased this add-on, you will need to reactivate your SmarterMail license key. 

Follow these steps to reactivate SmarterMail: 

1. Log in to SmarterMail as the system administrator.  

2. Click the settings icon. 

3. Expand the Activation folder in the navigation pane.  

4. Click Licensing in the navigation pane. Licensing information will load in the content 

pane. 

5. Click Reactivate in the content pane toolbar.  

The Exchange ActiveSync add-on is now activated for this installation of SmarterMail.  

For information on configuring mailboxes to synchronize email, calendars, tasks, and notes using 

the Exchange ActiveSync technology, please refer to the KB article 

 

Configure Microsoft Exchange ActiveSync 

for Email Accounts 

Applies to: SmarterMail 8.x (Enterprise only) 

Microsoft Exchange ActiveSync technology allows for over-the-air synchronization and push 

email to a wide range of mobile devices, including iPhone, Windows Mobile devices, Palm 

devices, Palm Pre (Web OS) devices, and Nokia devices. 

NOTE: Before you can configure a mailbox to sync using the Exchange ActiveSync technology, 

you must activate the Exchange ActiveSync add-on. For more information, please refer to the 

KB article How To -- Activate Microsoft Exchange ActiveSync. 

Follow these steps to enable Exchange ActiveSync for a specific mailbox: 

http://portal.smartertools.com/KB/a1397/activate-microsoft-exchange-activesync.aspx


1. Log in as the system administrator.  

2. Click the settings icon.  

3. Click ActiveSync Mailboxes in the navigation pane.  

4. Click Add in the content pane toolbar.  

5. In the Email Address field, type the full email address for the account for which you want 

to enable Exchange ActiveSync. 

6. Click Save.  

This mailbox can now use the Exchange ActiveSync technology to sync emails, calendars, tasks, 

and notes. 

 

Configure Exchange ActiveSync on the 

iPhone 

Applies to: MobileSyncMail 8.x (Enterprise only) 

 

Microsoft Exchange ActiveSync is available as an optional add-on to MobileSyncMail.  Unlike 

other synchronization methods, Exchange ActiveSync uses direct push technology to sync email, 

calendars, and contacts to the iPhone in real time.  

 

Once you have activated the Microsoft Exchange ActiveSync add-on and enabled Exchange 

ActiveSync for the specific MobileSyncMail mailbox, you will need to configure the iPhone to 

function with Exchange ActiveSync. 

 

To set up your iPhone to access Exchange ActiveSync, follow these steps: 

1. On your iPhone's home screen, tap Settings.  

2. Tap Mail, Contacts, Calendars.  

3. Tap Add Mail Account.  

4. Tap Microsoft Exchange.  

5. Complete the following required fields:  

o Email (your full email address)  

o Domain name  

o Username (with @domainname.com)  

o Password  

o Description (Optional) 

6. Tap Next.  

7. After a moment, the iPhone will ask for the server information. This is the URL to your 

webmail. For example, mail.example.com. NOTE: Do not include http:// when entering 

the server information.  

8. Tap Next.  

http://portal.smartertools.com/KB/a1397/activate-microsoft-exchange-activesync.aspx
http://portal.smartertools.com/KB/a1415/configure-microsoft-exchange-activesync-for-email-accounts.aspx
http://portal.smartertools.com/KB/a1415/configure-microsoft-exchange-activesync-for-email-accounts.aspx


9. If your webmail does not support SSL, the following message will display: "Exchange 

account verification failed."  

o Tap Next and then tap Save. Complete step 10 of these setup instructions.  

o After step 10, edit the account you just added.  

o Tap Account Info.  

o Change "Use SSL" to "Off."  

10. The iPhone will display a list of collaboration items to sync with Exchange ActiveSync. 

Choose from the list and tap Done to initiate the first sync.  

11.  

Sync MobileSyncMail with the iPhone Using 

CardDAV and CalDAV 

Applies to: MobileSyncMail 8.x Enterprise 

 

One method users can use to synchronize contacts, calendars and notes on the iPhone or iPad is 

the CalDAV and CardDAV protocols. NOTE: For ease of configuration on iPhone/Mac, the system 

administrator should set up a CalDAV and CardDAV SRV DNS record. This is what makes the 
iPhone/Mac auto discover settings.  
 

Configuring CardDAV 
Follow these steps to set up CardDav on the iPhone or iPad: 

1. Open the settings application. 

2. Tap Mail, Contacts, Calendars. 

3. Tap Add Account. 

4. Tap Other as account type. 

5. Tap Add CardDAV account. 

6. For server, type yourdomain.com 

7. Enter your full email address for User Name, and then type your password. 

8. Tap Next. 

9. If your mail server does not support SSL, a warning will be displayed. Tap Continue. 

10. If the iPhone is unable to verify the account information perform the following:  

o Tap OK. 

o Tap Advanced Settings. 

o Make sure Use SSL is set to OFF. 

o Change port to 80. 

o Account URL should be: http://yourdomain.com:80/WebDAV/ 

o Go back to account information and tap Save. 

11. Your contacts will now be visible in the Contacts application 

Configuring CalDAV 
Follow these steps to set up CalDav on the iPhone or iPad: 

1. Open the settings application. 



2. Tap Mail, Contacts, Calendars. 

3. Tap Add Account. 

4. Tap Other as account type. 

5. Tap Add CalDAV account. 

6. For server, type yourdomain.com 

7. Enter your full email address for User Name, and then type your password. 

8. Ta[ Next. 

9. If your mail server does not support SSL, a warning will be displayed. Tap Continue. 

10. If the iPhone is unable to verify the account information perform the following:  

o Tap OK. 

o Tap Advanced Settings. 

o Make sure Use SSL is set to OFF. 

o Change port to 80. 

o Account URL should be: http://yourdomain.com:80/WebDAV/ 

o Go back to account information and tap Save. 

11. Your calendar will now be visible in the Calendar application 

 

 

Configure IMAP for iPhone 

Applies to: MobileSyncMail 8.x 

The iPhone supports IMAP. IMAP will allow you to retrieve emails and folders from 

MobileSyncMail and leave the emails on the server.  

 

Follow these steps to create a MobileSyncMail IMAP connection to an iPhone or iPhone 3G 

with Firmware 2.0.x: 

1. On the iPhone, tap Settings.  

2. Tap Mail, Contacts, Calendars.  

3. Tap Add Account. 

4. Tap Other.  

5. Tap Add Mail Account. 

6. Complete the Name, Address (email address), Password and Description fields. 

7. Click Next.  

8. Ensure IMAP is selected.  

9. Enter your incoming mail server information:  

o Hostname is generally mail.yourdomainname.com. If you aren't sure, contact your 

email hosting company 

o Username is your full email address 

o Password is the same password used to access webmail. 

10. Enter your outgoing mail server information:  



o Hostname is generally mail.yourdomainname.com. If you aren't sure, contact your 

email hosting company 

o Username is your full email address 

o Password is the same password used to access webmail. 

11. Tap Next.  

12. The iPhone will attempt to establish an SSL connection to your IMAP and SMTP servers. 

If this succeeds, you will be done and can proceed to step 13. If this fails, you will see the 

prompt, "Do you want to try setting up the account without SSL?"  

o Tap No. 

o Tap Save. 

o When prompted, "This account may not be able to send or receive emails. Are 

you sure you want to save," tap Save. 

13. Tap the account you just added (identified by your email address)  

14. Scroll down and tap the SMTP button.  

15. Select the server you just added, identified by the hostname from step 9.  

16. Select OFF for Use SSL.  

17. Select Password for Authentication  

18. Select 25 for Server Port.  

19. Tap the SMTP button to go back.  

20. Tap your email address to go back.  

21. Tap Advanced.  

22. Scroll down to Incoming Settings.  

23. Select OFF for Use SSL.  

24. Select Password for Authentication.  

25. Select 143 for Server Port.  

26. Tap your email address to go back.  

27. Tap Mail to go back.  

28. Tap the Home button.  

29. Tap the Mail App to check your configuration.  

 

 

Synchronize MobileSyncMail with Mobile 

Devices Using SyncML 

Applies to: MobileSyncMail 8.x (Enterprise and Free editions only)  

MobileSyncMail uses the Funambol SyncML plug-in for synchronizing calendars, contacts, 

tasks, and notes with Microsoft Outlook, Mozilla Thunderbird, and most smar phones. Prior to 

synchronizing MobileSyncMail with your mobile device, please make sure that you have 

downloaded and installed the appropriate version of this plug-in. 

http://forge.ow2.org/project/showfiles.php?group_id=96


Sync Windows Mobile devices using SyncML  
Follow these steps to synchronize a Windows Mobile device: 

1. Using your Windows Mobile device, navigate to the Funambol plug-in. (The default 

location is under programs.) 

2. Open the Funambol plug-in. 

3. Select Sync All.  

4. After the sync is complete, click OK.  

Sync iPhone using SyncML 
Follow these steps to synchronize an iPhone: 

1. Using your iPhone, open the Funambol application. 

2. Tap Sync Contacts. 

3. After the sync is complete, close the application.  

Sync Blackberry using SyncML 
Follow these steps to synchronize a Blackberry phone: 

1. Using your Blackberry, navigate to the Funambol Blackberry plug-in. 

2. Open the Funambol plug-in. 

3. Press Menu. 

4. Select Synchronize from the drop-down list. 

5. After the sync is complete, close the application. 

 

 

Synchronize MobileSyncMail with Outlook 

Using the Add to Outlook Feature 

Applies to: MobileSyncMail 8.x (Enterprise and Free edition only)  

MobileSyncMail supports the two-way sync of MobileSyncMail calendars, contacts, and tasks 

with Outlook 2007 and Outlook 2010. Although the steps below show you how to sync your 

MobileSyncMail calendar with Outlook, the procedure is similar for synchronizing contacts and 

tasks. 

Follow these steps to sync your MobileSyncMail calendar with Outlook from the Web interface: 

1. From your computer that has Microsoft Outlook installed, log in to the MobileSyncMail 

web interface.  

2. Click the calendar icon.  



3. Click the Actions menu and then Add to Outlook in the navigation pane toolbar.  

4. This will open a new window that contains details about the connection you are about to 

make with Outlook. You may keep the default description and display names or type 

your own in the appropriate fields.  

5. Click OK.  

6. The will open the Launch Application window. Click OK to launch Outlook.  

7. To allow MobileSyncMail to connect with Outlook, click Yes.  

Your MobileSyncMail and Outlook calendars are now synchronized and any changes you make 

to the calendars will be updated in real time. 

 

 

Use LDAP with Outlook 

Applies to: MobileSyncMail 8.x 

 

Lightweight Directory Access Protocol (LDAP) is an Internet protocol that MobileSyncMail and 

Outlook can use to query directory services so users can easily find other email users on the 

domain. 

Outlook 2003 
Follow these steps to add the LDAP account into Outlook 2003: 

1. Open Outlook 2003.  

2. Go to Tools -> Email Accounts.  

3. Check Add a new directory or address book, then click Next.  

4. Select Internet Directory Service (LDAP), then click Next.  

5. Type in the IP or DNS resolvable name of the MobileSyncMail server.  

6. Check the This server requires me to log on check box and fill out the User Name and 

Password fields. Use your full email address for the User Name field.  

7. Click Next, then click Finish to complete the setup.  

8. Close and reopen Outlook.  

Follow these steps to access LDAP contacts in Outlook 2003: 

1. Click the New button to compose a new message.  

2. Click the To or Cc buttons to bring up a contact selection dialog.  

3. Click the Advanced button in the lower left of the dialog and click Find.  

4. Enter your search fields for the contact you are looking for. To display all contacts that 

are available via LDAP, just enter * in the Display name field.  

5. Click OK.  



6. Double click a contact to add it to the To recipients. To add it to To, Cc or Bcc just select 

the contact and click the appropriate button under the Message Recipients section.  

7. When you are finished adding recipients from LDAP, click OK to finish.  

Outlook 2007 
Follow these steps to add the LDAP account into Outlook 2007: 

1. Open Outlook 2007.  

2. Go to Tools -> Account SEttings.  

3. Click on the Address Books Tab and click New.  

4. Select Internet Directory Service (LDAP), then click Next.  

5. Type in the IP or DNS resolvable name of the MobileSyncMail server for the Server 

Name.  

6. Check the This server requires me to log on check box and fill out the User Name and 

Password fields. Use your full email address for the User Name field.  

7. Click Next, then click Finish to complete the setup.  

8. Close and reopen Outlook.  

Follow these steps to access LDAP contacts in Outlook 2007: 

1. Click the New button to compose a new message.  

2. Click the To or Cc buttons to bring up a contact selection dialog.  

3. Under The address book drop down menu select the MobileSyncMail server.  

4. Enter your search fields for the contact you are looking for. To display all contacts that 

are available via LDAP, just enter * in the Display name field.  

5. Click OK.  

6. Double click a contact to add it to the To recipients. To add it to To, Cc or Bcc just select 

the contact and click the appropriate button under the Message Recipients section.  

Outlook 2010 
Follow these steps to add the LDAP account into Outlook 2010: 

1. Open Outlook 2010.  

2. Click on the File tab and select Account Settings.  

3. Click on the Address Books Tab and click New.  

4. Select Internet Directory Service (LDAP), then click Next.  

5. Type in the IP or DNS resolvable name of the MobileSyncMail server for the Server 

Name.  

6. Check the This server requires me to log on check box and fill out the User Name and 

Password fields. Use your full email address for the User Name field.  

7. Click Next, then click Finish to complete the setup.  

8. Close and reopen Outlook.  

Follow these steps to access LDAP contacts in Outlook 2010: 

1. Click the New Email button to compose a new message.  



2. Click the To or Cc buttons to bring up a contact selection dialog.  

3. Under The address book drop down menu select the MobileSyncMail server.  

4. Enter your search fields for the contact you are looking for. To display all contacts that 

are available via LDAP, just enter * in the Display name field.  

5. Click OK.  

6. Double click a contact to add it to the To recipients. To add it to To, Cc or Bcc just select 

the contact and click the appropriate button under the Message Recipients section.  

 

 

 

Install and Configure Funambol SyncML for 

Outlook 

Applies to: MobileSyncMail 8.x (Enterprise only)  

MobileSyncMail uses multiple data synchronization technologies to sync mailbox data with 

email clients and mobile devices. SyncML is a platform-independent open standard for 

synchronization of information, and MobileSyncMail uses the Funambol SyncML plug-in to 

sync contacts, calendars, tasks, and notes with Outlook.  

Follow these steps to install and configure the Funambol SyncML plug-in for Outlook: 

1. Download the Funambol Sync Client for Microsoft Outlook.  

2. Install SyncML by double-clicking on the Funambol install and completing the 

installation wizard.  

3. After the install is complete, the Funambol Outlook Sync Client will open.  

4. To configure the sync settings, go to Tools and Options.  

5. Type the server location following the format http://domainame.com/sync/default.aspx.  

6. Type your full email address in the username.  

7. Type your email password in the appropriate field.  

8. Click the Sync icon to select which items should be synchronized (Contacts, Calendar, 

Tasks, Notes) and to schedule a sync interval.  

9. Click OK.  

The Funambol Sync Client for Microsoft Outlook is now configured to sync with 

MobileSyncMail. 

 

 

http://forge.ow2.org/project/showfiles.php?group_id=96


Install and Configure Funambol SyncML for 

Outlook 

Applies to: MobileSyncMail 8.x (Enterprise only)  

MobileSyncMail uses multiple data synchronization technologies to sync mailbox data with 

email clients and mobile devices. SyncML is a platform-independent open standard for 

synchronization of information, and MobileSyncMail uses the Funambol SyncML plug-in to 

sync contacts, calendars, tasks, and notes with Outlook.  

Follow these steps to install and configure the Funambol SyncML plug-in for Outlook: 

1. Download the Funambol Sync Client for Microsoft Outlook.  

2. Install SyncML by double-clicking on the Funambol install and completing the 

installation wizard.  

3. After the install is complete, the Funambol Outlook Sync Client will open.  

4. To configure the sync settings, go to Tools and Options.  

5. Type the server location following the format http://domainame.com/sync/default.aspx.  

6. Type your full email address in the username.  

7. Type your email password in the appropriate field.  

8. Click the Sync icon to select which items should be synchronized (Contacts, Calendar, 

Tasks, Notes) and to schedule a sync interval.  

9. Click OK.  

The Funambol Sync Client for Microsoft Outlook is now configured to sync with 

MobileSyncMail.  

 

http://forge.ow2.org/project/showfiles.php?group_id=96

